Oracle BI Cloud Connector Console

Creating a Business Intelligence Cloud Extract
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Preface</strong></td>
<td>i</td>
</tr>
<tr>
<td><strong>1 Get Started</strong></td>
<td>1</td>
</tr>
<tr>
<td>Overview of Business Intelligence Cloud Connector</td>
<td>1</td>
</tr>
<tr>
<td>Provision Access</td>
<td>2</td>
</tr>
<tr>
<td>Roadmap for the Cloud Extracts</td>
<td>4</td>
</tr>
<tr>
<td>Review View Object to Database Lineage Mappings</td>
<td>5</td>
</tr>
<tr>
<td>Sign In To BICC</td>
<td>6</td>
</tr>
<tr>
<td><strong>2 Implement</strong></td>
<td>7</td>
</tr>
<tr>
<td>Configure Where to Load Data</td>
<td>7</td>
</tr>
<tr>
<td>Create and Manage an Offering</td>
<td>9</td>
</tr>
<tr>
<td>Add a Datastore for an Offering</td>
<td>9</td>
</tr>
<tr>
<td>Configure Extract Preferences</td>
<td>10</td>
</tr>
<tr>
<td>Configure Flexfield Label Languages</td>
<td>12</td>
</tr>
<tr>
<td>Configure Offerings to Extract</td>
<td>12</td>
</tr>
<tr>
<td>Perform Advanced Extract Configuration</td>
<td>14</td>
</tr>
<tr>
<td><strong>3 Schedule an Extract</strong></td>
<td>17</td>
</tr>
<tr>
<td>Specify When to Extract Data</td>
<td>17</td>
</tr>
<tr>
<td>Create a New or Edit an Existing Data Extract Schedule</td>
<td>18</td>
</tr>
<tr>
<td>Preview and Edit a Datastore for an Offering</td>
<td>20</td>
</tr>
<tr>
<td>Add a Job</td>
<td>21</td>
</tr>
<tr>
<td>Manage Job Data Stores</td>
<td>23</td>
</tr>
<tr>
<td>Preview and Edit Job Data Stores</td>
<td>24</td>
</tr>
<tr>
<td>Customize Job Data Stores</td>
<td>25</td>
</tr>
<tr>
<td>Add a Job Schedule</td>
<td>26</td>
</tr>
<tr>
<td>View Last Run Status for a Cloud Data Extract</td>
<td>27</td>
</tr>
<tr>
<td>View Last Run Status for a Deleted Record Extract</td>
<td>28</td>
</tr>
<tr>
<td>Reset Last Extract Date For All Enabled Data Stores</td>
<td>28</td>
</tr>
</tbody>
</table>
### 4 Administer

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Files in External Storage for Custom Warehouse Integration</td>
<td>29</td>
</tr>
<tr>
<td>Encrypt Extracts</td>
<td>31</td>
</tr>
<tr>
<td>Decrypt Extracts</td>
<td>32</td>
</tr>
</tbody>
</table>

### 5 Integrate

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>SOAP API</td>
<td>33</td>
</tr>
<tr>
<td>REST API</td>
<td>41</td>
</tr>
</tbody>
</table>
Preface

This preface introduces information sources that can help you use the application.

Using Oracle Applications

Help

Use help icons ❓ to access help in the application. If you don't see any help icons on your page, click your user image or name in the global header and select Show Help Icons. Not all pages have help icons. You can also access the Oracle Help Center to find guides and videos.

Watch: This video tutorial shows you how to find and use help.

You can also read about it instead.

Additional Resources

- **Community:** Use Oracle Cloud Customer Connect to get information from experts at Oracle, the partner community, and other users.
- **Training:** Take courses on Oracle Cloud from Oracle University.

Conventions

The following table explains the text conventions used in this guide.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong></td>
<td>Boldface type indicates user interface elements, navigation paths, or values you enter or select.</td>
</tr>
<tr>
<td><strong>monospace</strong></td>
<td>Monospace type indicates file, folder, and directory names, code examples, commands, and URLs.</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than symbol separates elements in a navigation path.</td>
</tr>
</tbody>
</table>

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website.

Videos included in this guide are provided as a media alternative for text-based help topics also available in this guide.
Contacting Oracle

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit My Oracle Support or visit Accessible Oracle Support if you are hearing impaired.

Comments and Suggestions
Please give us feedback about Oracle Applications Help and guides! You can send an e-mail to: oracle_fusion_applications_help_ww_grp@oracle.com.
1 Get Started

Overview of Business Intelligence Cloud Connector

You can use Oracle Business Intelligence Cloud Connector (BICC) to extract business intelligence and other data in bulk and load it into designated external storage areas. BICC is available as part of the Oracle Applications Cloud subscription. Additional access provisioning is required and you must sign into BICC to perform all tasks related to the data extraction. Details about access provisioning are provided in the Provision Access section.

After you sign into BICC, you can select the offerings from which to extract data, and also specify whether you want to store the extracts on a dedicated external cloud storage or load them into Oracle Universal Content Management (UCM). The extracted data is secure because the security standards applied to Oracle Applications Cloud extend to BICC as well. Let's look at what you can do with BICC to extract data from the products available in your implementation:

- Configure an external storage location that works for your data needs.
- Extract complete or partial data. You can select offerings or specific objects.
- Run extracts on-demand or schedule them to run at specified intervals during the day, in a week, or throughout the month.
- Run incremental extracts if you need only the data that changed since your last extract.
- Schedule multiple independent extracts at convenient intervals.
- Monitor extracts and review logs.
- Export configured offerings and associated data stores.
- Manage refresh metadata and specify dates for incremental refresh comparison.

Here's a simple illustration of the workflow for storing, running, and managing the extracts.
This chapter introduces you to BICC and covers some of the basic tasks required to set up BICC. The subsequent chapters cover details about configuring and running the extracts, and managing the extraction process thereafter.

**Note:** Use BICC to extract data from the data stores and store them in an external storage for future retrieval and use. For details about downloading the data from external storage, refer to the external storage product documentation.

### Provision Access

#### Overview of Access Provisioning

Before you prepare extracting data from any of the Oracle Cloud applications, you must configure the user credentials with access to the BICC Console and the data files generated by BICC and store on the UCM server.

You need access to BICC to select the offerings, identify what you want to extract, and where do you want to store the extracted data. You need access to the files stored on the UCM server so that you can view and download the extracted data.

Access to BICC Console and UCM are provisioned through different roles. In the following topics, you will find details about provisioning users for both BICC Console and UCM.
Provision a User with Access to BICC

Before you begin, you must set up a user who can access BICC. You must set up the access using the Security Console of Oracle Applications Cloud. Therefore, make sure you have the Security Manager role assigned to you so that you can access the Security Console.

1. Sign in to Oracle Applications Cloud and click **Navigator > Tools > Security Console**.
2. Click the Roles tab and click **Create**.
3. On the Basic Information page, enter the following values and click **Next**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Role Name</td>
<td>BIACM_ADMIN</td>
</tr>
<tr>
<td>Role Code</td>
<td>BIACM_ADMIN</td>
</tr>
<tr>
<td>Role Category</td>
<td>BI - Abstract Roles</td>
</tr>
</tbody>
</table>

5. On the Role Hierarchy page, click **Add Role**.
6. On the Add Role Membership dialog box, search for the following roles and click Add Role Membership to add them.
   - **ESS Administrator Role**: To create and manage schedules for global data extracts or jobs.
   - **ORA_ASM_APPLICATION_IMPLEMENTATION_ADMIN_ABSTRACT**: To have access to global offerings and data stores or jobs.
7. Close the Add Role Membership dialog box and click **Next**.
8. Skip entering details on the Segregation of Duties page and click **Next**.
9. On the Users page, click **Add User**.
10. On the Add User dialog box, search for and select the user to whom you want to assign this role.
11. Click **Add Selected Users** and close the dialog box.
12. Click **Next**. Review the summary and click **Save and Close**.

Provision a User with Access to BICC Content on UCM

Along with the access to BICC Console, you must also ensure that the user has access to the BICC generated content that's stored on the UCM server. The extract files are stored in the OBIAImport security group on the UCM server. Use the Security Console of Oracle Applications Cloud to provide the user with access to this security group. Make sure you have the Security Manager role assigned to you so that you can sign into the Security Console.

1. Sign in to Oracle Applications Cloud and click **Navigator > Tools > Security Console**.
2. Click the Roles tab and click **Create**.
3. On the Basic Information page, enter the following values and click **Next**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Role Name</td>
<td>BICC_UCM_CONTENT_ADMIN</td>
</tr>
<tr>
<td>Role Code</td>
<td>BICC_UCM_CONTENT_ADMIN</td>
</tr>
<tr>
<td>Role Category</td>
<td>BI - Abstract Roles</td>
</tr>
</tbody>
</table>
5. On the Role Hierarchy page, click Add Role.
6. On the Add Role Membership dialog box, search for OBIA_EXTRACTTRANSFORMLOAD_RWD and click Add Role Membership. This role membership is required to view and download the extract files on UCM.
7. Close the Add Role Membership dialog box and click Next.
8. Skip entering details on the Segregation of Duties page and click Next.
10. On the Add User dialog box, search for and select the user to whom you want to assign this role.
11. Click Add Selected Users and close the dialog box.
12. Click Next. Review the summary and click Save and Close.

Roadmap for the Cloud Extracts

After the accounts are provisioned, you are ready to do the next steps to extract data. The following graphical representation helps you to plan and complete the tasks in the indicated sequence.

To provide a quick reference, the individual tasks are elaborated and tabulated here. You can use the task descriptions as mapped points and go to the relevant topics for details.

<table>
<thead>
<tr>
<th>Task Group</th>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get Started</td>
<td>Sign in to BICC</td>
<td>Use the provisioned account and sign in.</td>
</tr>
<tr>
<td></td>
<td>Set BICC Console Preferences</td>
<td>Personalize the console as per your preferences.</td>
</tr>
<tr>
<td></td>
<td>Review View Object to Database Lineage Mappings</td>
<td>Review and understand how the BI view objects and database lineages are mapped.</td>
</tr>
<tr>
<td>Implement</td>
<td>Select BIVO</td>
<td>Select any of the offerings and select the associated BIVO(s).</td>
</tr>
</tbody>
</table>
### Get Started

<table>
<thead>
<tr>
<th>Task Group</th>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Configure External Storage</strong></td>
<td>Select a storage location for the cloud extract files.</td>
</tr>
<tr>
<td><strong>Schedule an Extract</strong></td>
<td>Run an Extract</td>
<td>Create an extract schedule or execute data extract for the selected BIVOs.</td>
</tr>
<tr>
<td></td>
<td>Schedule an Extract</td>
<td>You can create and execute multiple extract schedules and data extracts.</td>
</tr>
<tr>
<td><strong>Administer</strong></td>
<td>Monitor an Extract</td>
<td>You can view last cloud extract and check error messages in the case of failures. You can check scheduled jobs' logs to review issues causing errors and get support to resolve them.</td>
</tr>
<tr>
<td></td>
<td>Download extract files</td>
<td>Download the extracted files from the configured storage location.</td>
</tr>
</tbody>
</table>

### Review View Object to Database Lineage Mappings

Before you actually extract data, you must know the BI View Objects (VOs) and their corresponding database tables and columns. The mappings are already available in the spreadsheets hosted on the Oracle Cloud Customer Connect site.

**Note:** Lineage only includes data stores that have predefined extract definition and are shipped with Oracle Applications Cloud.

To review the mappings, follow these steps.

1. Click the link here that corresponds to your product and navigate to the Oracle Cloud Customer Connect portal.
   - *R13.x HCM BI Cloud Adapter BI View Object to Database Lineage Mapping Spreadsheet*
   - *R13.x FSCM BI Cloud Adapter BI View Object to Database Lineage Mapping Spreadsheet*
   - *R13.x CX BI Cloud Adapter BI View Object to Database Lineage Mapping Spreadsheet*

2. On the Reporting and Analytics page for your product, review the information and click the link to the recently published .zip file.
3. On prompt, download the .zip file to a location on your local computer.
4. Extract the contents of the .zip file. The extracted folder contains spreadsheets that list the mappings of the BI VOs to database tables and columns.
5. Use the information in the spreadsheet to search for a View Object, the corresponding Database Table and Database Column.

**Tip:** Use the filters to narrow down and find names of the VOs that are required for your extracts.

To know more about the tables and columns for the respective product areas, see related links for the corresponding Tables and Views guides.
Sign In To BICC

Open any browser and enter the URL in the format `<https://<saas cloud host name>:<saas cloud port number>/biacm>`. Alternatively, you can use the web link supplied to you by Oracle Cloud Support. On the sign-in page, enter your credentials and sign in to BICC.

Preferences

Immediately after you sign in to BICC, set your preferences even before you start working with it. You can set preferences such as regional settings, display language, and accessibility options.

1. On the panel tab, click Preferences.
2. Set these preferences:
   - Click Regional to specify the date, time, number, and time zone details.
   - Click Language to specify your preferred language.
3. Click Save.

Now you are ready to proceed with the data extracts.

Accessibility

To set your accessibility preferences:

1. Click the Accessibility icon on the global header of the BICC Console.
2. On the Enable Accessibility Preferences page, select the check boxes of the preferences you want to enable and click Apply.
2 Implement

Configure Where to Load Data

Click the **Configure External Storage** button in the panel tab and select the **Configure External Storage** link to open the Configure External Storage dialog box, where you can specify storage areas into which Cloud data is loaded. For example, to load into one or more Oracle Cloud Storage Service instances, select the Storage Service Connection Configuration tab. Select the OCI Object Storage Connection tab to configure Cloud Infrastructure connections, and select the UCM Connection Configuration tab to configure Universal Content Management Server connections.

Storage Type — Cloud Storage Service

To specify the connection details for one or more Oracle Storage Service instances, click the name of a provisioned connection or click **Add** to create a new connection. Click **Delete** to delete an existing connection.

Storage areas are associated with extract schedules. You can have as many Cloud Storage Service containers as are required by your Cloud application integrations, but each should be used for its own requirements, so that there's no overlap between them. Runtime metadata, including the last extract date, is managed across all storage locations, so configuring the same data store in multiple schedules with different external storage configurations results in loss of incremental data.

Use the following fields in the Storage Service Connection page to specify the connection details:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>How to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Specify a name for the connection.</td>
</tr>
<tr>
<td>OAC External Storage</td>
<td>Select this option if the connection is to an Oracle Analytics Cloud (OAC) storage service. You can specify only one OAC storage service connection. Note that encryption is disabled for OAC storage.</td>
</tr>
<tr>
<td>Protocol</td>
<td>Specify http for non-SSL, or https for SSL connection.</td>
</tr>
<tr>
<td>Host</td>
<td>Specify the Host name for the Oracle Storage Service. For example, mystorage.storage.oraclecloud.com.</td>
</tr>
<tr>
<td>Port</td>
<td>Specify the port number (optional).</td>
</tr>
<tr>
<td>User Name</td>
<td>Specify the user that is provisioned to load data. The user should have privileges to upload files in the container specified. User credentials will be stored in the Weblogic credential store under oracle.apps.security/FUSION_APPS_OBIA_STORAGESERV_USER-KEY.</td>
</tr>
<tr>
<td>Password</td>
<td>Specify the password for the user specified in the User Name field.</td>
</tr>
<tr>
<td>Service Name</td>
<td>Specify the service name of the Oracle Cloud Storage Service. For example, gse-otbie1.</td>
</tr>
<tr>
<td>Container</td>
<td>Specify the name of the container that is allocated to upload extracted files. Click <strong>Refresh</strong> button to refresh the list of the containers. It's a good idea to check the storage service connection. Click <strong>Test Storage Service Connection</strong> to verify successful connection.</td>
</tr>
</tbody>
</table>
## Field Name | How to Use
--- | ---
Data Encryption — Support Encryption | If you want to encrypt communication, select this option and use the Import Certificate option to specify the encryption keys.
Import Certificate | Click **Browse** and navigate to and select the location of the key file, or type the literal path location and file name.
Download Folder | Shows the directory in the domain server where the Batch Extract file is downloaded to reset extract dates before the extraction process.
Upload Folder | Shows the directory in the domain server where files are temporarily extracted by the cloud extractor before uploading to the storage service.

### Storage Type — OCI Object Storage Connection
Use the following fields in the Configure External Storage page to specify the connection details:

## Field Name | How to Use
--- | ---
Name | Specify a name for the connection.
Host | Specify host name. Host information is available in *Object Storage Service API* in the OCI API Documentation.
Tenancy OCID | Specify Tenancy OCID. To obtain the Tenancy and user OCID, refer to this to *Where to Get the Tenancy’s OCID and User’s OCID*.
User OCID | Specify User OCID.
Namespace | Specify the namespace. Namespace is obtained in the OCI Console.
Bucket | Specify the bucket into which extracts are uploaded. Bucket names are obtained in the OCI Console.
Generate API Signing Key | Generate the required API signing key for OCI. The fingerprint is displayed after generation.
Export Public Key | Export the public key for upload to OCI.
Test Connection | Test the connection.

### Storage Type — UCM
Review the connection details for Universal Content Management (UCM) using the following fields:

## Field Name | How to Use
--- | ---
Protocol | Specify http for non-SSL, or https for SSL. If you select https here, you must also enable HTTPS on the UCM server, using the UCM Server Console.
Host | Shows the host name for the UCM Server. For example, **myserver.companyname.com**
Create and Manage an Offering

Click Actions > Create Offering in the Offerings dialog to open the Manage Offering dialog, where you can specify a new offering and associate a data store.

Manage Offering

<table>
<thead>
<tr>
<th>Field Name</th>
<th>How to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Offering Code</td>
<td>Enter a code for the offering.</td>
</tr>
<tr>
<td>Offering Name</td>
<td>Enter a name for the offering. This is the name that will appear in the list of Business Intelligence Applications Offerings in the Configure Cloud Extract dialog.</td>
</tr>
<tr>
<td>Offering Description</td>
<td>Optionally, enter a description.</td>
</tr>
</tbody>
</table>

Associate Data Store

In the Associate Data Store section of the dialog, filter for the data store, then select and click the Move selected items to other list button to add the VO, then click Save.

Add a Datastore for an Offering

You can add a data store and specify its details for an offering.

1. On the Data Stores for Offering page, click the Add button.
2. On the Data Store Settings page, enter these details to specify a new data store for the selected offering.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>How to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Store Key</td>
<td>Enter a key for the data store. This is a mandatory field and is used in the validation process.</td>
</tr>
<tr>
<td>Query Filter</td>
<td>Enter a filter to restrict the returned data when you run the query. All column references should</td>
</tr>
<tr>
<td>Field Name</td>
<td>How to Use</td>
</tr>
<tr>
<td>------------</td>
<td>------------</td>
</tr>
<tr>
<td></td>
<td>follow the format underscore (_ ) underscore ( _ ) DATASTORE underscore ( _ ) underscore ( _ ) dot(.)&gt;BI VO Column Name&gt;, for example select <strong>DATASTORE</strong>._ViewApplicationId=0 where ViewApplicationId is the column name in the BI VO and of data type number. Similarly, to filter results based on timestamp, you can follow the format <strong>DATASTORE</strong>._CostDistributionLinesEOLastUpdateDate &gt;= TIMESTAMP ‘2019-01-15 07:45:00’ where the results are filtered as per the given parameter TIMESTAMP ‘2019-01-15 07:45:00’. You can use the appropriate operators such as = or &gt;= to get the expected results. If you don’t enter Query Filter, the field displays &quot;(none)&quot; after you save the details.</td>
</tr>
</tbody>
</table>

Data Store Options

- **Silent Error**: When selected, errors on a data store that occur during the extract are ignored. Deselect it if you want to display the errors during the extract process.
  
  **Note**: When Silent Error is enabled and if the scheduled BICC extract fails, the files already extracted are preserved inspite of the extract failure. But if this option is not selected and the extract fails, the already extracted files are removed.

- **Disable Effective date filter**: Select this option to extract all historical records, and not use the date filter. Note that the VO when not validated is considered effective dated in nature. So, set this option only after confirming the nature of the data.

- **Extract Data Store Metadata**: This option is selected by default. When selected, this option generates an .mdcsv file with the data extract.

- **Use UNION ALL for incremental extract**: Enable this if you schedule incremental extracts.

3. In the Associate Offerings section, from the Available Offerings list, select the offerings you want to associate with the data store. Click the Move button to move the selected items to the Selected Offerings list.

   **Tip**: You may double-click an offering in the Available Offerings list to move it to the Selected Offerings list. Double-click an offering in the Selected Offerings list to reverse the selection.

4. Click Save. The details of the newly added data store appear.

   To modify details of the newly added data store, click Edit Data Store Details. To define columns for extraction, click Select Columns. The column definitions are retrieved from the BI repository.

   For more information, refer to the topic *Preview and Edit a Data Store for an Offering*.

### Configure Extract Preferences

Click Actions > Extract Preferences to open the Extract Preferences dialog, where you can specify preferences for extracts.
Language
In the Preferred Extract Language field, select language you'd prefer extracts be made in.

Prune Time in Minutes
Default BICC incremental job will add a look back timeframe as defined in Prune time setting. Since the extraction is done on live Applications DB and not a snapshot, look back/prune time is best practice to ensure dependency synchronization across objects. Default works best for extracts with daily or higher reoccurrence. Prune time should be adjusted when extracts are scheduled more frequently or if downstream system can handle objects extracted in any order.

Job Settings
In the Timeout in Hours field, enter the number of hours before a job times out. The default is 10. By default, the job fails on timeout. Deselect Timeout Force Fail if you prefer that timed out jobs not be failed.

**Note:** If timed out jobs aren’t failed, all data files for all data stores that were successful before the timeout are uploaded to external storage.

File Parameters
In the Compression type field, select the type of compression you’d like to use. In the Split file size (GB) field, specify the file size by which extracted CSV files are divided for a single VO. The default is 1 GB. You can set the file size from one to five GB.

In the Uploaded file expiry (Days) field, enter the number of days you’d like the extract files to persist.

File Parameters settings can be overridden at the schedule level when creating schedules and assigning external storages to them.

External Storage
Select the **Upload to Multiple External Storage** option to increase the number of external storages that can be selected in the External Storage list when creating or editing schedules. The default is one storage, and the maximum is two.

Retry Parameters
During extraction, connections to the BI Server or queries may fail, causing retries. In the Analytic server connection retry limit field, specify the number of connection attempts made to complete the extraction. In the Analytic server query retry limit field, specify the number of times a query is resubmitted.

The Analytic server connection retry limit setting can be overridden at the schedule level when creating schedules and assigning external storages to them.

Global Extract Schedule Notification
To send notifications when scheduled extract events occur, select the notifications you want upon extract start, success, or failure. In the Mail To Addresses, enter email addresses, separated by commas, to which you want notifications sent.
Global Extract Schedule Notification settings can be overridden at the schedule level when creating schedules and assigning external storages to them.

**Configure Flexfield Label Languages**

Click Actions > Configure Flex Label Languages in the Offerings dialog to open the Configure Flex Label Languages dialog, in which you can specify a language for flex labels.

In the Flex Label Languages list, scroll to select the language you want, then click the **Move selected items to other list** button to add it to the selected list, then click **Save and Close**. To suspend extraction of flexfield labels during extraction, select the **Suppress Flex Label Extract** option.

**Configure Offerings to Extract**

Click the **Manage Offerings and Data Stores** button in the panel tab and select the **Manage Offerings and Data Stores** link to open the Offerings dialog box, where you can select offerings that you want to extract, specify VOs from which to extract data, and set up once-only or regular data extracts.

**Offerings**

<table>
<thead>
<tr>
<th>Field Name or Option</th>
<th>How to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Offerings list</td>
<td>View the offerings that are available for extraction. Click an offering to view and configure its data stores.</td>
</tr>
<tr>
<td>Search</td>
<td>Enter an offering name and click Search to locate it in the list.</td>
</tr>
<tr>
<td>Actions &gt; Create Offering</td>
<td>Create a new offering and specify its VOs.</td>
</tr>
<tr>
<td>Actions &gt; Reset Last Extract Date</td>
<td>Specify the last extract date from which extraction should begin for incremental loads.</td>
</tr>
<tr>
<td>Actions &gt; Configure Flex Label Languages</td>
<td>Specify a language for flexfield labels.</td>
</tr>
<tr>
<td>Actions &gt; Extract Preferences</td>
<td>Specify extract parameters, including: job timeout; CSV file size to split files by; retry parameters in case of intermittent BI Server connection or query failures; and extract schedule email notification frequency and recipients.</td>
</tr>
<tr>
<td>List View</td>
<td>View the Offerings list as a list with Actions icon for each offering.</td>
</tr>
<tr>
<td>Grid View</td>
<td>View the Offerings list as a grid with Actions icon for each offering.</td>
</tr>
<tr>
<td>Offering Action &gt; Delete</td>
<td>Delete the currently selected offering and its corresponding VO association. Available only for user-defined offerings.</td>
</tr>
<tr>
<td>Offering Action &gt; Edit</td>
<td>Change the Offering Name and VO association of the currently selected offering.</td>
</tr>
<tr>
<td>Offering Action &gt; Reset to Shipped Content</td>
<td>Reset the offering to shipped content, removing any changes made.</td>
</tr>
</tbody>
</table>
### Field Name or Option

<table>
<thead>
<tr>
<th>How to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Offering Action &gt; Reset to Full Extract</td>
</tr>
<tr>
<td>Offering Action &gt; Reset All Data Stores To Shipped Content</td>
</tr>
</tbody>
</table>

Click the **Manage Offerings and Data Stores** button in the panel tab and select the **Export Modification** link to collect modification information from the source environment and export it as compressed CSV files.

You can export all jobs or a specific job. To export a specific job, click **Manage Offerings and Data Store** button and select **Export Modification**. On the Export Modification dialog box, click the **Jobs** checkbox, select the specific job from the drop-down list, and click **OK**.

Select the **Import Modification** link to apply modifications to the destination environment using the exported compressed CSV files. On the Import Modification dialog box, click **Browse** and select the exported files, and click **Import**.

*Note:* If you reset all data stores at the offering level before performing the import, the PVOs attain the schema definition of the imported files.

## Data Store for Offering: Offering name

Click an offering in the Offerings list open the Data Store for Offering: Offering Name page, where you can specify View Objects VOs from which to extract data.

<table>
<thead>
<tr>
<th>Field Name or Option</th>
<th>How to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Stores list</td>
<td>View the data areas that are available for extraction for the offering you clicked.</td>
</tr>
<tr>
<td>View &gt; Columns</td>
<td>Select columns to be displayed in the Offerings list.</td>
</tr>
<tr>
<td>View &gt; Detach</td>
<td>Pop out the section of the dialog box so you can see more data.</td>
</tr>
<tr>
<td>View &gt; Reorder Columns</td>
<td>Change the display order of the columns in the Data Stores list.</td>
</tr>
<tr>
<td>View &gt; Query By Example</td>
<td>Filter the displayed results by entering the first few letters of a name.</td>
</tr>
<tr>
<td>Add</td>
<td>Specify a new Data Store for an offering. For example, you might want to add a view object (VO) for extraction. To add a VO, in the wizard's Datastore details page, provide the VO name, then specify whether you want to disable effective data filter, which allows for extraction of all historical records, if required. Enter any required query filter, using column references following the format <strong>DATASTORE</strong>.&lt;BI VO Column Name&gt;. In the wizard's Select Columns page, select the column types for the select query from the Column Filter drop-down list, then uncheck the columns you don't want included in the <strong>SELECT</strong> list. If the VO is defined as Effective Date Disabled, you can select the Natural Key option for a Primary Key Column to define a natural key.</td>
</tr>
<tr>
<td>Remove</td>
<td>Delete the currently selected Data Store.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Refreshes the Data Store list.</td>
</tr>
<tr>
<td>Query by Example</td>
<td>Filter the displayed results by entering the first few letters of a name.</td>
</tr>
<tr>
<td>Detach</td>
<td>Pop out the section of the dialog box so you can see more data.</td>
</tr>
</tbody>
</table>
## Field Name or Option

<table>
<thead>
<tr>
<th>Field Name or Option</th>
<th>How to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actions &gt; Reset to Full Extract</td>
<td>Reset the last extract date so that a full data load is performed at the next load for the data store/VO, instead of an incremental load. You typically use this option if your business requirements have changed or if fact data has been corrupted.</td>
</tr>
<tr>
<td>Actions &gt; Reset to Shipped Content</td>
<td>Reset the VO to shipped content, removing any changes made.</td>
</tr>
</tbody>
</table>
| Actions > Export Metadata Definition (MDCSV)                                         | Export metadata definition for the data store in the MDCSV format. The selected data store content is exported into a zip file that you can download. Here’s some additional information about this format:  
  - File extension: `.mdcsv`  
  - Delimiter: `|||` (three vertical pipes)  
  - Includes Primary Key columns: Yes  
  - Includes Incremental columns: No  
  - Includes Select List columns: No  
  You can extract the metadata definition in this format when you run the data extracts. |
| Actions > Export Metadata Definition (CSV)                                           | Export metadata definition for the data store in the CSV format. The selected data store content is exported into a zip file that you can download. Here’s some additional information about this format:  
  - File extension: `.csv`  
  - Delimiter: `,` (comma)  
  - Includes Primary Key columns: Yes  
  - Includes Incremental columns: Yes  
  - Includes Select List columns: Yes  
  You can’t extract the metadata definition in this format when you run the data extracts. |
| Actions > Export UI Label                                                             | Export user interface labels for the VO. A zip file is generated with files for each configured language.                                 |
| Actions > Download Sample CSV File                                                  | Verify the sample extract from the selected data store.                                                                                   |
| Actions > Advanced Extract Configuration                                            | Specify initial extract date and chunking for creation date and primary key for full loads.                                               |
| Last Extract Date                                                                   | View the date and time when the Data Store was last extracted.                                                                           |

Click the **Configure Cloud Extract** button in the panel tab and select the **Review Cloud Extract Configuration** link to return to the Enabled Data Stores dialog box.

## Perform Advanced Extract Configuration

You can set advanced extracts configurations when you run full extracts. You can use advanced extract configuration settings when you extract numeric or CLOB data types.

1. On the Data Store for Offering page, use Actions > Advanced Extract Configuration for a data store to open Advanced Extract Configuration.
2. In the Advanced Extract Configuration page, you can set advanced extract configurations for a selected data store. For full extracts, you can enable chunking by creation date or by primary key.
Filter and/or Chunk By Creation Date Columns

<table>
<thead>
<tr>
<th>Field Name</th>
<th>How to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial Extract Date</td>
<td>Optionally, specify the initial date from which the full extract should be performed. This option requires selection of the Is Creation Date option for a column or columns in the column list, which represent the Creation Date.</td>
</tr>
<tr>
<td>Support chunking</td>
<td>Optionally, select By Creation Date to chunk by to specify a number of days by which to extract date range batches or chunks of data. This option requires selection of the Is Creation Date option for a column or columns in the column list, which represent the Creation Date.</td>
</tr>
<tr>
<td>Number of Days</td>
<td>If you selected to support chunking by creation date, specify the number of days, for example 365, by which to chunk extracts.</td>
</tr>
<tr>
<td>Columns</td>
<td>View the columns that are available for designation as creation date. Select the Is Creation Date option for the appropriate column.</td>
</tr>
</tbody>
</table>

Chunk By Primary Key Column

<table>
<thead>
<tr>
<th>Field Name or Option</th>
<th>How to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Support chunking</td>
<td>Support chunking by numeric primary key. This option requires a single numeric primary key column for the data store.</td>
</tr>
<tr>
<td>Number of Rows</td>
<td>Specify a number of rows to chunk extracts by.</td>
</tr>
</tbody>
</table>

Extract as String

In the Extract as String tab, you can select columns that are of numeric or CLOB data types for conversion. Select the **Cast to String** checkbox to extract numeric columns with more than 15 digits and CLOB data types. This setting trims the CLOB data to the character string limits supported by VARCHAR datatype.
3 Schedule an Extract

Specify When to Extract Data

Click the Manage Extract Schedules button in the panel tab and select the Manage Extract Schedules link to open the Manage Extract Schedules dialog, where you can set up a once-only or regular data extract of Business Intelligence data from an Oracle Applications Cloud data source. For example, you might want to extract data from your Cloud data source once per day at midnight. You can also monitor an extract here.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>How to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schedules</td>
<td>This list shows schedules submitted in the last 24 hours. Use the Add option to set up once-only or regular data extract. Use the Edit option to update the details of the currently selected schedule. Use the Delete Schedule option to delete the currently selected schedule. It’s recommended that you periodically purge the Schedules list, as not all completed schedules are shown. To do this, use the Delete Inactive Schedules option.</td>
</tr>
<tr>
<td>Schedule Requests</td>
<td>This list shows the details of data extract processes for the Schedule that’s currently selected in the Schedules list. A new row is created in the table every time an Cloud extract request is processed. Use the Delete option to delete the details of the currently selected request. If you delete a schedule job from this list, then this doesn’t remove the BI Cloud data that’s been extracted and loaded by that job.</td>
</tr>
</tbody>
</table>

Monitor a Cloud Extract

In the Schedules dialog, click Actions and select the option for the last run corresponding to the job type, Cloud Data Extract or Deleted Record Extract. Each job type displays in its own dialog, which lists the last cloud extract or deleted record extract status of each VO with status of SUCCESS or FAILURE for each data store and error messages in the case of failures. The ESS Request Id column displays the job for which the VO extraction last ran.

Scheduled jobs also write logs that can be used to review issues causing errors or shared with Oracle Support to resolve a service request. To download logs, click Help and select Download Logs.

For scheduled jobs, whether successful or not, an extraction status file in JSON format is uploaded to external storage. The files have a default expiration date, and have the following file name format, depending on job type:

- Cloud Data Extracts: `EXTRACT_STATUS_DATA_SCHEDULE_<Schedule Id>_REQUEST_<request_id>.JSON`
- Deleted Record Extracts: `EXTRACT_STATUS_DELETED_SCHEDULE_<Schedule Id>_REQUEST_<request_id>.JSON`

<table>
<thead>
<tr>
<th>Column</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>VO name</td>
</tr>
<tr>
<td>status</td>
<td>VO extract status</td>
</tr>
<tr>
<td>errorMessage</td>
<td>If extract failed, any resulting error status</td>
</tr>
<tr>
<td>runDate</td>
<td>Run date of the extract of the VO</td>
</tr>
</tbody>
</table>
Create a New or Edit an Existing Data Extract Schedule

In the Manage Extract Schedules dialog, click **Add** or **Edit** to create a new Cloud data extract or edit an existing one. For example, you might want to extract data from your Cloud data source once per day at midnight. For a once-only data extract, use the **Simple** option in the **Recurrence** drop down list. You can only create a schedule if there isn't an active schedule for the selected job type (for example, Cloud Data Extract, Deleted Record Extract, or Data and Delete Record Extract). Click **Next** to specify the data stores for extract for an offering in the Data Store List page.

### Schedule Details

<table>
<thead>
<tr>
<th>Field Name or Option</th>
<th>How to Use</th>
</tr>
</thead>
</table>
| Job Type             | To extract data, select **Application Data Extract**. To sync the Cloud system to your source data, select **Active Primary Key Extract**, which extracts primary key values to identify deleted records. To combine both Cloud Data Extract and Delete Record Extract into one job, select **Application Data and Active Primary Key Extract**.  
To purge expired files from Universal Content Management (UCM), select **Delete Expired UCM Files**. When a file is extracted and uploaded to UCM, it has a default expiration of 90 days. Expired files are soft deleted from UCM and may eventually require purging to preserve space. The job deletes only expired files from the OBIAImport security group.  
To delete all of the files uploaded to one or more selected external storages, select **Delete Files in Storage**. For a storage service, this job deletes all files from the container associated with the external storage. For UCM, it deletes all file uploaded to the OBIAImport security group. |
| Name                 | Specify a short name to identify the schedule in the Schedules list. |
| Description          | Specify a brief description to identify the schedule, which is only displayed on the Edit Schedule dialog. |
| Global Data Store List| Accept the default of **No** to select data stores for extraction. Select **Yes** to use the Global Data Store. |
| Recurrence           | Specify how often you want the extract to be performed. To create a once-only data extract, select **Simple**. |
| Hourly Interval      | Specify the number of hours to perform hourly interval extracts by (if you select Hourly in the Recurrence list). |
| Date and Time        | Specify the date and time to perform a once-only extract (if you select Simple in the Recurrence list). |
## Oracle BI Cloud Connector Console

### Chapter 3

**Creating a Business Intelligence Cloud Extract**

#### Schedule an Extract

<table>
<thead>
<tr>
<th>Field Name or Option</th>
<th>How to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time</td>
<td>Specify the time to start an extract, in the format HH:MM:SS AM</td>
</tr>
<tr>
<td>Day</td>
<td>For weekly schedules, select the check box next to each day on which you want to extract data. For Monthly or Yearly extracts, select the day of the month on which you want to extract data.</td>
</tr>
<tr>
<td>Month</td>
<td>For Yearly (annual) schedules, select the month in which you want to extract data.</td>
</tr>
</tbody>
</table>

**Data Store List**

<table>
<thead>
<tr>
<th>Field Name or Option</th>
<th>How to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Offering</td>
<td>Select an offering to extract.</td>
</tr>
<tr>
<td>Data Store List</td>
<td>Lists the data stores for a selected offering.</td>
</tr>
<tr>
<td>Enabled for Extract</td>
<td>Select to enable a data store for extract.</td>
</tr>
<tr>
<td>Query By Example</td>
<td>Filter the displayed results by entering the first few letters of a name.</td>
</tr>
<tr>
<td>Detach</td>
<td>Pop out the section of the dialog box so you can see more data.</td>
</tr>
</tbody>
</table>

**External Storage**

For seamless integration, you can configure a schedule to use application-specific storage service containers, allowing you to schedule extracts for multiple integrations.

**Note:** To optimize the extraction flow and force reuse of the extracted data files across integrations, it's preferable that separate storage containers be used when there's no overlap on the data stores required for each integration. Runtime metadata, including the last extract date, is managed across all storage locations, so configuring the same data store in multiple schedules with different external storage configurations results in loss of incremental data. If an overlap on the data stores is required, you can enable advanced extract options for extract jobs to upload the same data files to two separate external storage locations. To do this, select the Upload to Multiple External Storage option in the Extract Preferences dialog box.

<table>
<thead>
<tr>
<th>Field Name or Option</th>
<th>How to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>External Storage</td>
<td>For extracts, select a data store to upload the extract to. By default, you can select one. If the Upload to Multiple External Storage option is selected in your extract preferences, you can select two data stores if an overlap of the data stores is required.</td>
</tr>
<tr>
<td></td>
<td>If you're deleting expired UCM files, the UCM external storage is selected. If you're deleting files in storage, select one or more from the list of external storages to delete.</td>
</tr>
<tr>
<td>Notification</td>
<td>Select one of the following options: Use Global Extract Notification to use the global settings defined in the Extract Preferences dialog box; Define Notification to set notifications for the schedule and override the global settings; or None. the notifications you want upon extract start, success, or failure. In the Mail To Addresses, enter email addresses, separated by commas, to which you want notifications sent.</td>
</tr>
<tr>
<td>Notify On</td>
<td>If you have selected Define Notification for the schedule, select the notifications you want upon extract start, success, or failure.</td>
</tr>
</tbody>
</table>
### Schedule an Extract

<table>
<thead>
<tr>
<th>Field Name or Option</th>
<th>How to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mail to Addresses</td>
<td>Enter email addresses, separated by commas, to which you want notifications sent.</td>
</tr>
<tr>
<td>Use Global File Parameters</td>
<td>Select Yes to use the global file parameter settings defined in the Extract Preferences dialog box. Select No to set parameters for the schedule and override the global settings.</td>
</tr>
<tr>
<td>Compression Type</td>
<td>Select the type of compression you’d like to use for the schedule.</td>
</tr>
<tr>
<td>Split file size (GB)</td>
<td>Specify the file size by which extracted CSV files are divided for a single VO for the schedule. The default is 1 GB. You can set the file size from one to five GB.</td>
</tr>
<tr>
<td>Uploaded file expiry (Days)</td>
<td>Enter the number of days you’d like the extract files to persist for the scheduled extract.</td>
</tr>
</tbody>
</table>

### Preview and Edit a Datastore for an Offering

You can view the details of the existing data stores. If there are any changes, you can modify them and plan to re-extract, if necessary.

#### Preview a Data Store

1. On the Manage Offerings and Data Stores tab, click the Manage Offerings and Data Stores link.
2. On the Offerings page, from the list of offerings, click an offering for which you want to view the data stores.
3. On the Data Stores for Offerings page, click a data store to view the data store information.

You can view the following information:
- Data store code.
- Query filter
- Data store options
- Associated offerings
- Data store columns for which the attributes such as incremental key, primary key, and so on are set

#### Edit Data Store Details

Click the Edit Data Store Details button to edit the saved data store details. You may modify the query filter, select or deselect the data store options, and change the list of offerings. You can also download the sample CSV file to preview, if required. Save the edits you make before leaving the page.

#### Select Columns

Click the Select Columns button to modify the list of selected columns that are to be included in the extract. On the Data Store Column Selection page, you can select the columns and make modifications using the various options available. These are explained here:
- Select the check box in the Include column to select a data store column. Selecting the check box in the Primary Key column automatically selects the check box in the Include column.
- Use the Search Column Names field to enter specific keywords and filter the list of columns.
• Use Filter to filter results by various column types. By default, it's set to Show All. Here is a brief description about the other filter options:
  ◦ Date Type Columns: Filters and displays columns that have TIMESTAMP as the data type. For such columns, the extracted data might store a detailed timestamp value.
  ◦ Varchar Type Columns: Filters and displays columns that support data of type varchar.
  ◦ Numeric Type Columns: Filters and displays columns that contain only numeric data. These columns mostly contain various IDs that are generated or assigned.
  ◦ Primary Key Columns: Filters and displays columns that are primary keys.
  ◦ Incremental Key Columns: Filters and displays columns that store incremental keys.
  ◦ Deprecated Columns: Filters and displays deprecated columns, if any.

• Click the Select drop-down list to make bulk selection or deselection of columns. Use Revert to undo the last select all or unselect all action.
• Click Actions > Retrieve PK to reset the primary keys.

Once you make all the changes, click Save. The columns that you select here for inclusion appear on the Data Store Details page.

Add a Job

You can create jobs, specify and manage their data stores, and schedule and run them using refresh metadata at the job level, isolating them from global refresh dates.

1. Click the Manage Jobs panel tab and click the Manage Jobs link.
2. On the Manage Jobs page, click the Add button.
3. On the Add Jobs page, enter these details to create a new job and manage its refresh metadata.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>How to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the job.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of the job.</td>
</tr>
<tr>
<td>Offerings</td>
<td>From the drop-down list, select the offering that contains the data stores you want to include in the job.</td>
</tr>
<tr>
<td>Enabled for Extract</td>
<td>Select the check box for the data store that you want to enable for extract.</td>
</tr>
</tbody>
</table>

4. Click Save. The job is added and the page navigates to the Manage Jobs page.

If you want to modify the job details, click the job name. The Job Details page appears where you can do the following:

• To edit details of the job, click the Edit button. On the Edit Job page, you can modify the job details. For more information on modifying the job details, refer to the topic Manage Job Data Stores.
• To modify the data store details, click the data store name. You are taken to the page where you can modify the data store details. For more information on modifying the data store details, refer to the topic Preview and Edit Job Data Stores.
Manage Jobs

Manage jobs helps you extract data from Oracle Applications Cloud to support multiple downstream integrations. All data stores' metadata is managed at the job level.

Use can use these options to manage the jobs that you added:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>How to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jobs list</td>
<td>View the extract jobs that are available for extraction. Click a job link to view the job definition and configure its data stores.</td>
</tr>
<tr>
<td>View &gt; Columns</td>
<td>Select columns to be displayed in the Jobs list.</td>
</tr>
<tr>
<td>View &gt; Detach</td>
<td>Pop out the section of the dialog box so you can see more data.</td>
</tr>
<tr>
<td>View &gt; Reorder Columns</td>
<td>Change the display order of the columns in the Jobs list.</td>
</tr>
<tr>
<td>View &gt; Query By Example</td>
<td>Enter the first few letters of the search string and press Enter.</td>
</tr>
<tr>
<td>Add</td>
<td>Specify a name, description for the job, and data stores. The data store metadata definitions are copied to the new job definition. If the data stores have been modified at the global level, the modified versions of the metadata are picked.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete the currently selected job.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Refreshes the Jobs list.</td>
</tr>
<tr>
<td>Detach</td>
<td>Pops out the table into a separate dialog box to provide better view of the contents.</td>
</tr>
<tr>
<td>Query By Example</td>
<td>A shortcut button for the same feature that's available in View &gt; Query By Example.</td>
</tr>
<tr>
<td>Actions &gt; Copy</td>
<td>Copy the selected job definition. Schedules for the job aren't copied.</td>
</tr>
<tr>
<td>Actions &gt; Reset to Full Extract</td>
<td>Reset the last extract date so that a full data load is performed at the next load for all data stores/VOs selected for the job, instead of an incremental load.</td>
</tr>
<tr>
<td>Actions &gt; Reset Last Extract Date</td>
<td>Rest the last extract date for all the data stores within the job.</td>
</tr>
<tr>
<td>Actions &gt; Manage Initial Extract Date</td>
<td>Specify the initial extract date for all the data stores in the job that have at least one creation date column.</td>
</tr>
<tr>
<td>Actions &gt; Manage Batch Mode Preferences</td>
<td>Specify whether to run the job in batch mode. By default, all data stores defined in a job definition have the Silent Error flag enabled. To turn off the Silent Error flag for all job data stores, set the job to batch mode.</td>
</tr>
</tbody>
</table>

Export and Import Jobs

You can export and import job definitions and any associated job schedules. Definitions are exported in JSON with naming standard `exportJob_<Year>-<Month>-<Day>-<Hour>-<Minute>-<Second>.zip`.

To export jobs, click the Manage Jobs button and select the Export Jobs link to open the Export Jobs dialog box, where you can specify whether to include active schedules in the export. To import jobs and any associated schedules, click the Manage Jobs button and select the Import Jobs link to open the Import Jobs dialog box, where you can browse for an exported JSON file and import it.
Manage Job Schedules

Use these options to view and manage your job schedules:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>How to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search</td>
<td>Use the Job list to filter for specific jobs and the Submission Time After field to decrease the submission time window displayed in the Schedules and Schedule Requests lists. The schedules for the last 24 hours are displayed by default.</td>
</tr>
<tr>
<td>Schedules list</td>
<td>This list shows currently defined schedules. Use the Add option to set up a one-time or recurring data extract job schedules. Use the Edit option to update the details of the currently selected schedule. To delete a schedule, cancel it and then use the Delete option to delete it.</td>
</tr>
<tr>
<td>Schedule Requests</td>
<td>This list shows the details of data extract processes for the Schedule that's currently selected in the Schedules list. A row in this table corresponds to an ESS request. For a recurring schedule, there will be multiple rows. For each row, you can click the State of the request to download the ESS log. Select the View All Runs checkbox to view all the ESS requests corresponding to the schedule. Use the Delete option to delete the details of the currently selected request. If you delete a schedule job from this list, then this doesn't remove the BI Cloud data that's been extracted and loaded by that job.</td>
</tr>
</tbody>
</table>

Manage Job Data Stores

Click a job in the Jobs list open the Job Details: Job Name page, where you can view and specify data stores from which to extract data. Modify the job data store details as required.

Job Details: Job name

<table>
<thead>
<tr>
<th>Field Name or Option</th>
<th>How to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit</td>
<td>Edit job name, job description, and job data stores.</td>
</tr>
<tr>
<td>Edit Group</td>
<td>Edit the order of execution within the job. Select the group number and specify group item priority for each data store.</td>
</tr>
<tr>
<td>Done</td>
<td>Close the dialog box and return to Manage Jobs.</td>
</tr>
<tr>
<td>Actions &gt; Compare Shipped Metadata</td>
<td>Compare shipped data store metadata with modified metadata side-by-side.</td>
</tr>
<tr>
<td>Actions &gt; Reset to Full Extract</td>
<td>Reset the last extract date so that a full data load is performed at the next load for the data store/VO, instead of an incremental load.</td>
</tr>
<tr>
<td>Actions &gt; Reset to Shipped Content</td>
<td>Reset all the data stores in the job to shipped content.</td>
</tr>
</tbody>
</table>
| Actions > Export Metadata Definition (MDCSV) | Export metadata definition for the data store in the MDCSV format. The selected data store content is exported into a zip file that you can download. Here’s some additional information about this format:  
  - File extension: .mdcsv  
  - Delimiter: ||| (three vertical pipes)  
  - Includes Primary Key columns: Yes                                                                                                                 |
### Field Name or Option

<table>
<thead>
<tr>
<th>How to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Includes Incremental columns: No</td>
</tr>
<tr>
<td>• Includes Select List columns: No</td>
</tr>
</tbody>
</table>

You can extract the metadata definition in this format when you run the data extracts.

### Actions > Export Metadata Definition (CSV)

Export metadata definition for the data store in the CSV format. The selected data store content is exported into a zip file that you can download.

Here's some additional information about this format:

| • File extension: .csv |
| • Delimiter: , (comma) |
| • Includes Primary Key columns: Yes |
| • Includes Incremental columns: Yes |
| • Includes Select List columns: Yes |

You can't extract the metadata definition in this format when you run the data extracts.

### Actions > Export UI Label

Export user interface labels for the VO. A zip file is generated with files for each configured language.

### Actions > Download Sample CSV File

Verify the sample extract from the selected data store.

### Actions > Advanced Extract Configuration

For full extracts, use Advanced Configuration to apply filter or chunk. Ensure to select Cast to String checkbox in Extract as String tab to extract numeric or CLOB data types. This setting supports CLOB data up to the character string limits supported by VARCHAR datatype. If data is larger, the extract would fail.

---

### Preview and Edit Job Data Stores

On the Job Details page, you can modify the job details. You can also view or modify the details of the associated data stores.

#### Edit Job Details

1. On the Job Details page, click the Edit button.
2. Modify the job name and description, if required.
3. To add or remove offerings, click the Offerings drop-down list and select or deselect the Enable for Extract check box for the identified offerings.
4. Click Save.

#### Edit Job Data Store Details

1. On the Job Details page, click the data store name that's listed in the Data Store column. The link opens the data store page.
2. Click Edit Data Store Details. On the Data Store Settings page, you can do the following:
   - Click the Download Sample CSV File to validate the data store and download a sample CSV file.
   - Add or modify the Query Filter.
   - Select or deselect the Data Store Options.
3. Click Save.

Select Columns

1. On the Job Details page, click the data store name that’s listed in the Data Store column. The link opens the data store page.
2. Click Select Columns. On the Data Store Column Selection page, you can do the following:
   a. Click the Download Sample CSV File to validate the data store and download a sample CSV file.
   b. Include or exclude the data store columns based on your extract preferences.
3. Click Save.

Customize Job Data Stores

Click Customize in the Preview Data Store dialog box to open the Customize Job Data Store for job: Job Name dialog box. All modifications for a data store are stored for the current job.

Customize Data Store for Job

<table>
<thead>
<tr>
<th>Field Name or Option</th>
<th>How to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable Effective Date Filter</td>
<td>Enable this option if there’s a requirement to extract all historical records. Note that the VO not validated as being effective dated in nature, so set this option only after confirming the nature of the data</td>
</tr>
<tr>
<td>Extract Data Store Metadata</td>
<td>Enable this option to extract data store metadata with the job, for example attribute definitions.</td>
</tr>
<tr>
<td>Silent Error</td>
<td>Default is to use silent error. Deselect to allow errors.</td>
</tr>
<tr>
<td>Use OTBI metadata dependent extract</td>
<td>Select to use OTBI Metadata Dependent Mode for the data store. The default, OTBI Metadata Independent Mode, allows extraction without a dependency for BIVO metadata in the BI repository (RPD).</td>
</tr>
<tr>
<td>Use UNION ALL for incremental extract</td>
<td>The default incremental extract strategy is to use OR. Select this option to use UNION ALL.</td>
</tr>
<tr>
<td>Query Filter</td>
<td>Specify a query to filter the data.</td>
</tr>
<tr>
<td>Support Chunking</td>
<td>Chunk data for large data VOIs, splitting the output into chunks by initial extract date, creation date, or primary key. Set an Initial Extract date to filter data on that date for data store columns defined as Creation Date, and select the preferred chunking option in the Support Chunking list.</td>
</tr>
</tbody>
</table>

**Note:** Silent Error ignores the errors on a VO during an extract. When Silent Error is enabled and the scheduled BICC extract fails, the PVO files already extracted by the same schedule are preserved inspite of the BICC extract failure. On the contrary, if Silent Error is disabled and the scheduled BICC extract fails, the PVO files already extracted by the same schedule are removed.
Add a Job Schedule

Click the Manage Jobs button and select the Manage Job Schedules link to open the Manage Job Schedules dialog box, where you can manage job level schedules.

Manage Job Schedules

<table>
<thead>
<tr>
<th>Field Name or Option</th>
<th>How to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schedules list</td>
<td>This list shows currently defined schedules. Use the Add option to set up once-only or regular data extract. Select a schedule to view or update its details. Click the Cancel Schedule button to cancel a scheduled extract, and the Delete Schedule button to delete the currently selected schedule.</td>
</tr>
<tr>
<td>Schedule Requests list</td>
<td>This list shows the details of data extract processes for the Schedule that is currently selected in the Schedules list. A new row is created in the table every time an Cloud extract request is processed. Use the Cancel option to cancel a scheduled run or delete the details of the currently selected request. If you delete a schedule job from this list, the data that’s been extracted and loaded by that job isn’t removed.</td>
</tr>
</tbody>
</table>

In the Manage Job Schedules dialog box, click Add to create a new Cloud data extract or click a schedule to preview an existing one and edit it if it’s a recurring schedule.

<table>
<thead>
<tr>
<th>Field Name or Option</th>
<th>How to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job</td>
<td>Specify the job you’re creating the schedule for.</td>
</tr>
<tr>
<td>Name</td>
<td>Specify a short name to identify the schedule in the Schedules list.</td>
</tr>
<tr>
<td>Job Type</td>
<td>To extract data, select Application Data Extract. To sync the job data stores to your source data, select Active Primary Key Extract, which extracts primary key values to identify deleted records. To combine both Application Data Extract and Active Primary Key Extract into one job, select Application Data and Active Primary Key Extract.</td>
</tr>
<tr>
<td>Description</td>
<td>Specify a brief description to identify the schedule.</td>
</tr>
<tr>
<td>External Storage</td>
<td>Select the external storage for the schedule.</td>
</tr>
<tr>
<td>Recurrence</td>
<td>Specify how often you want the extract to be performed. To create a once-only data extract, select Simple.</td>
</tr>
<tr>
<td>Hourly Interval</td>
<td>Specify the number of hours to perform hourly interval extracts by (if you select Hourly in the Recurrence list).</td>
</tr>
<tr>
<td>Date and Time</td>
<td>Specify the date and time to perform a once-only extract (if you select Simple in the Recurrence list).</td>
</tr>
<tr>
<td>Time</td>
<td>Specify the time to start an extract, in the format HH:MM:SS AM</td>
</tr>
<tr>
<td>Day</td>
<td>For weekly schedules, select the check box next to each day on which you want to extract data. For Monthly or Yearly extracts, select the day of the month on which you want to extract data.</td>
</tr>
<tr>
<td>Month</td>
<td>For Yearly (annual) schedules, select the month in which you want to extract data.</td>
</tr>
</tbody>
</table>
Field Name or Option | How to Use
--- | ---
Notification | Select one of the following options: Use Global Extract Notification to use the global settings defined in the Extract Preferences dialog box; Define Notification to set notifications for the schedule and override the global settings; or None. the notifications you want upon extract start, success, or failure.
Notify On | If you have selected Define Notification for the schedule, select the notifications you want upon extract start, success, or failure.
Mail to Addresses | Enter email addresses, separated by commas, to which you want notifications sent.
Use Global File Parameters | Select Yes to use the global file parameter settings defined in the Extract Preferences dialog box. Select No to set parameters for the schedule and override the global settings.
Compression Type | Select the type of compression you’d like to use for the schedule.
Split file size (GB) | Specify the file size by which extracted CSV files are divided for a single VO for the schedule. The default is 1 GB. You can set the file size from one to five GB.
Uploaded file expiry (Days) | Enter the number of days you’d like the extract files to persist for the scheduled extract.

Monitor Extracts

In the Schedules list, click Actions and select the option for the last run corresponding to the job type, Application Data Extract or Active Primary Key Extract. Each job type displays in its own dialog box, which lists the last extract status of each VO with status of SUCCESS or FAILURE for each data store and error messages in the case of failures. The ESS Request Id column displays the job for which the VO extraction last ran. You can also select a job in the Job list to filter the results.

View Last Run Status for a Cloud Data Extract

In the Manage Extract Schedules dialog, click Actions and select a a last run status for a run type to view logging and status for each VO for the last extraction job for each, indicated by the ESS Request Id. Click Detach to expand the dialog to full size.

Statuses

The status for each data store is displayed in the Status column. In the event of an error, the error message is displayed in the Message column. Status includes:

- ERROR: Extract failed with the error message displayed in the Message column.
- EXTRACT_SUCCESS: Extract ran successfully.
- UPLOAD_SUCCESS: Upload to external storage ran successfully.
View Last Run Status for a Deleted Record Extract

In the Manage Extract Schedules dialog, click Actions and select Last Run Status for Active Primary Key Extract to open the Last Run Status for Active Primary Key Extract dialog, which provides logging and status for each VO for the last extraction job for each, indicated by the ESS Request Id. Click Detach to expand the dialog to full size.

Statuses

The status for each data store is displayed in the Status column. In the event of an error, the error message is displayed in the Message column. Status includes:

- ERROR: Extract failed with the error message displayed in the Message column.
- EXTRACT_SUCCESS: Extract ran successfully.
- UPLOAD_SUCCESS: Upload to external storage ran successfully.

Reset Last Extract Date For All Enabled Data Stores

Click Actions > Reset Last Extract Date in the Offerings dialog to open the Reset Last Extract Date For All Enabled Data Stores dialog.

Specify the last extract date from which extraction should begin for incremental loads for the selected Offering. You typically use this option if your business requirements have changed or when fact data has been corrupted. Click OK to reset.
4 Administer

Manage Files in External Storage for Custom Warehouse Integration

During an extract, view object (VO) data in compressed files is uploaded to an external storage with a manifest file. The manifest file lists the uploaded files from the current batch. Use the information in the manifest file to process data. For a custom warehouse implementation, you must manage the manifest file and its contents. This section explains the types of files that BICC generates and their properties.

Files Uploaded to External Storage
BICC generates the following files:

<table>
<thead>
<tr>
<th>File Type</th>
<th>Description</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Data Files</td>
<td>Comma-separated value data files that contain extracted BIVO data, and are uploaded as compressed files.</td>
<td>.csv</td>
</tr>
<tr>
<td>Metadata Files</td>
<td>Comma-separated value files that contain metadata with details about columns and data type definitions for Data Stores (BIVOs).</td>
<td>.mdcsv</td>
</tr>
<tr>
<td>Primary Key Extract Files</td>
<td>Comma-separated value data files that contain data from primary key columns. You can use this data to delete records in your downstream application, such as a warehouse.</td>
<td>.pecsv</td>
</tr>
<tr>
<td>Manifest Files</td>
<td>These files contain information about the uploaded files.</td>
<td>.mf</td>
</tr>
</tbody>
</table>

Note:
- The .csv, .pecs, and .mdcdv files are individually zipped. For example, ‘file_crmanalyticsam_budgetam_budget-batch1510381061-20190517_004657_<time in milli secs>.zip’. The time differs for each zip file.
- To support parsing of the comma-separated value files, column values are wrapped in double quotes. The double quote value in the column is escaped using two consecutive double quote values. Because of this, a custom delimiter isn’t required.
- The decimal floating point numbers will have rounding errors due to representational limitations of binary floating point formats in BICC. For example, a decimal number such as 1.365 may be represented as 1.364999999999999 when converting to DOUBLE type.
CAUTION: To ensure column names are sorted and appear in the ascending (deterministic) order in the extracted files, you must select columns in the BI Cloud Connector Console. If you don't select columns then BI Cloud Connector Console determines the columns available at run time and includes them in the extract files. Adding or removing a column in the BI Cloud Connector Console changes the order of columns in the extract files.

Manifest File Formats and Content

The first line of a manifest file describes the source version. File name format depends on the configure storage area and are detailed in a manifest file.

In UCM MANIFEST.MF files, the body of the file contains information about each of the uploaded files in the format vo_name;ucm_document_id;md5_check_sum_value. For example, in the following sample line, from a UCM manifest file, 9526 is the UCM document ID of the uploaded file, ;b2af2bf486366e2c2cb7598849f0df2e is the check sum value.

crmanalyticsam_partiesanalyticsam_customer;9526;b2af2bf486366e2c2cb7598849f0df2e

In Cloud Storage Service MANIFEST-[TIMESTAMP].MF files, the body of the file contains information about each of the uploaded files in the format extract_uploaded_filename;md5_check_sum_value. For example, in the following sample line, from a Storage Service manifest file, file_fscmtopmodelam_analyticsserviceam_currenciestlpvo-batch1209716923-20150615_105514.zip is the uploaded file name, and ;b2af2bf486366e2c2cb7598849f0df2e is the check sum value.

file_fscmtopmodelam_analyticsserviceam_currenciestlpvo-batch1209716923-20150615_105514.zip;fa981be0caf70a9a52df3aceb9998cc9

Global Data Extract Manifest

- UCM will have MANIFEST.MF.
- Cloud Storage Service and OCI Object Storage manifest files have a file name format as MANIFEST-[Timestamp].MF.
- EXTRACT_STATUS_DATA_SCHEDULE_<SCHEDULE ID>_REQUEST_<REQUEST_ID>.JSON is common for all data extracts.
- EXTRACT_STATUS_PRIMARY_KEYS_SCHEDULE_<SCHEDULE ID>_REQUEST_<REQUEST_ID>.JSON is common for all key extracts.

Jobs Manifest

Job specific extracts have the following Manifest file format:

- Data Extract
  MANIFEST_DATA_<JOB_ID>-SCHEDULE_<SCHEDULE ID>_REQUEST_<ESS_REQUEST_ID>.MF
  EXTRACT_STATUS_DATA_<JOB_ID>-SCHEDULE_<SCHEDULE ID>_REQUEST_<ESS_REQUEST_ID>.JSON

- Keys Extract
  MANIFEST_PRIMARY_KEYS_<JOB_ID>-SCHEDULE_<SCHEDULE ID>_REQUEST_<ESS_REQUEST_ID>.MF
  EXTRACT_STATUS_PRIMARY_KEYS_<JOB_ID>-SCHEDULE_<SCHEDULE ID>_REQUEST_<ESS_REQUEST_ID>.JSON
Download and Process Content from UCM

To download extracted content from UCM, search for DOCTITLE MANIFEST.MF and sort by DOCDATE in DESC order. This provides all of the manifest UCM files in order by docid. Download each MANIFEST file using docid. Parse the lines in the manifest file to download data files using their respective ucm_document_ids. You can use the md5_check_sum_value to verify downloaded file content. After downloading the files, unzip them and process them based on their file extension, for example by .csv, .mdcsv, or .pecsv.

Once the data files are processed, rename the corresponding MANIFEST.MF file in UCM by adding a timestamp prefix in the format [TIMESTAMP]_MANIFEST.MF so that it’s not reused in the next download from UCM. Expire the manifest file and all the processed files after 30 days so that UCM storage doesn’t run out of space.

Download and Process Content from Cloud Storage Service

To download extracted content from Cloud Storage Service, search for MANIFEST- and sort by filename. This provides all of the manifest files in order by date. Download each manifest file and parse the lines in the manifest file to download data files using their respective file names. You can use the md5_check_sum_value to verify downloaded file content. After downloading the files, unzip them and process them based on their file extension, for example by .csv, .mdcsv, or .pecsv.

Once the data files are processed, rename the corresponding manifest file in Storage Service by adding a timestamp prefix in the format [TIMESTAMP]_MANIFEST so that it’s not reused in the next download. Expire the manifest file and all the processed files after 30 days so that storage doesn’t run out of space.

Encrypt Extracts

BI Cloud Connector supports signed and unsigned encryption using Pretty Good Privacy (PGP) for files uploaded to Universal Content Management (UCM). Optionally, you can enable signed extract files and download a generated signing key.

Before you set up encryption, generate a key pair using PGP and export the public key from the key pair to a location from which it can be imported. Encryption is performed using an imported public key. You can use the private key from the key pair to decrypt your extracts.

To set up encryption for a data store:

1. Click the Configure External Storage button in the panel tab and select the Configure External Storage link to open the Configure External Storage dialog box.
2. Select the UCM Connection Configuration tab.
3. In the Data Encryption section, select Data Encryption.
4. Click Choose File to import the certificate from the key pair you generated. In the File Upload dialog box, navigate to your key file, select it, and click Open. Click Update... to update a key. Imported certificates are stored in the GnuPG keyring on the server host.
5. Optionally, select Sign Extract File to generate a signing key for your extracts.
6. If you choose to sign the extract files, click the Download Signing Key button to save the signing key.
   a. In the Opening biccc.gpg dialog box, select Save File and click Browse to select a location to save the signing key.
   b. Click Save.
7. In the Key list, select the Key Id, then click Actions > Set as default to set a default key.
8. To delete a key, select Actions > Delete.

Encrypted extracts uploaded to UCM are stored with a suffix of .gpg.
Decrypt Extacts

BI Cloud Connector encrypts files before upload to Universal Content Management using the imported certificate you provide. Use your private key to decrypt uploaded files.

To decrypt and verify signed files, download the signing key and verify that the keys are imported into the keystore and appear in the Key list in the Configure External Storage dialog box. Use the following command to decrypt both signed and unsigned .gpg files:

```
gpg --decrypt <inbound_file_name> --output <output_file_name>
```
## 5 Integrate

### SOAP API

Use Simple Object Access Protocol (SOAP) web services to integrate different applications within the enterprise or expose business functions to Oracle Cloud partners and customers. SOAP helps you submit various XML requests to extract desired data. You can execute data extraction and schedule jobs using SOAP web services.

**Access SOAP API**

Before you schedule extracts, here’s how you can access SOAP API and submit SOAP requests.

1. **WSDL Server URL**: For all supported operations, use https://servername.fa.us2.oraclecloud.com/bi/ess/esswebservice?wsdl
2. **SOAP Requests**: To submit SOAP requests, use https://servername.fa.us2.oraclecloud.com/bi/ess/esswebservice

### Global Extract with Given Data Stores

Let’s learn how to use the ESS web service to schedule a job for running the BI cloud extracts.

ESS web service is a SOAP web service that provides operations to submit requests and request status for the submitted jobs. Here’s what you need to do to schedule an extract:

- Configure the data stores in BICC console.
- Create global extract for specified data stores.

<table>
<thead>
<tr>
<th>SOAP Headers</th>
<th>Procedure</th>
</tr>
</thead>
</table>
| Security     | - Add username token for authentication with username and password.  
               - Add timestamp token with ‘created’ and ‘expires’ for the message time validation. |
| SOAP Body    | Provide details for the following attributes in the SOAP Body.  
               - Job Name: BICloudConnectorJobDefinition  
               - Package: oracle.apps.ess.biccc  
               - Type: JOB_DEFINITION  
               - Start Time: Provide start time under sch:requestedStartTime. If left null, the extract process will start immediately.  
               - sch:application: oracle.biacm (hosting application)  
               - Request Parameters  
               - SYS_className:oracle.esshost.impl.CloudAdaptorJobImpl (Classname in the hosting app running the job)  
               - EXTRACT_TYPE: Job Type of the extract. Valid values are VO_EXTRACT (Cloud Data Extract)/PRIMARY_KEY_EXTRACT (Deleted Records Extract)/VO_AND_PK_EXTRACT (Cloud Data and Deleted Records extract) |
<table>
<thead>
<tr>
<th>SOAP Headers</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>c. Sys_application:BI Cloud Adaptor</td>
<td></td>
</tr>
<tr>
<td>d. DATA_STORE_LIST: Comma separated list of data stores for which the extract will be run. If you don't provide this list, the extracts will be run for the global data store list enabled in BICCC.</td>
<td></td>
</tr>
<tr>
<td>• Optional Preferences: You can specify the following optional preferences. You can specify data type as STRING for all the parameters.</td>
<td></td>
</tr>
<tr>
<td>a. STARTED_NOTIFICATION - Send notification email when the extract begins? (true/false)</td>
<td></td>
</tr>
<tr>
<td>b. SUCCESS_NOTIFICATION - Send notification email when the extract succeeds? (true/false)</td>
<td></td>
</tr>
<tr>
<td>c. FAILURE_NOTIFICATION - Send notification email when the extract fails? (true/false)</td>
<td></td>
</tr>
<tr>
<td>d. MAIL_TO_ADDRESSES – Provide comma separated list of email addresses to send the notifications emails.</td>
<td></td>
</tr>
<tr>
<td>e. FILE_EXPIRY_DAYS - Number of days after which the uploaded files will be expired.</td>
<td></td>
</tr>
<tr>
<td>f. FILE_SPLIT_SIZE - Split size (MB) for the extract files.</td>
<td></td>
</tr>
<tr>
<td>g. EXTRACT_COMPRESS_TYPE - Compression type for the files (zip/gzip)</td>
<td></td>
</tr>
</tbody>
</table>

**Sample Request**(submitRequest)

```xml
<soapenv:Envelope xmlns:sch="http://xmlns.oracle.com/scheduler"
 xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/"
 xmlns:typ="http://xmlns.oracle.com/scheduler/types">
 <soapenv:Header>
  <wsse:Security soapenv:mustUnderstand="1"
  xmlns:wsse="http://docs.oasis-open.org/wss/2004/01/oasis-200401-wss-wssecurity-secext-1.0.xsd"
  xmlns:wsu="http://docs.oasis-open.org/wss/2004/01/oasis-200401-wss-wssecurity-utility-1.0.xsd">
   <wsu:Timestamp wsu:Id="TS-A2DF758C7B92C012301520468873404">
    <wsu:Created>2018-03-08T00:28:07.339Z</wsu:Created>
    <wsu:Expires>2018-03-08T00:30:07.339Z</wsu:Expires>
   </wsu:Timestamp>
   <wsse:UsernameToken wsu:Id="UsernameToken-A2DF758C7B92C012301520468873403">
    <wsse:Username>xxxxxxx</wsse:Username>
    <wsse:Password Type="http://docs.oasis-open.org/wss/2004/01/oasis-200401-wss-username-token-profile-1.0#PasswordText">xxxxxxx</wsse:Password>
    <wsu:Created>2018-03-08T00:27:58.740Z</wsu:Created>
   </wsse:UsernameToken>
  </wsse:Security>
 </soapenv:Header>
 <soapenv:Body>
  <sch:submitRequest>
   <sch:description>Test ESS Web Service</sch:description>
   <sch:jobDefinitionId>
    <!--Optional:-->
    <typ:name>BICloudConnectorJobDefinition</typ:name>
    <!--Optional:-->
    <typ:packageName>oracle.apps.ess.biccc</typ:packageName>
    <!--Optional:-->
    <typ:type>JOB_DEFINITION</typ:type>
   </sch:jobDefinitionId>
   <sch:application>oracle.biacc</sch:application>
   <sch:requestParameters>
    <!--0 to 1000 repetitions:-->
   </sch:requestParameters>
   <sch:requestParameters>
    <!--Optional:-->
    <typ:parameter/>
    <!--Optional:-->
   </sch:requestParameters>
 </sch:submitRequest>
</soapenv:Body>
</soapenv:Envelope>
```
Oracle BI Cloud Connector Console
Creating a Business Intelligence Cloud Extract

Chapter 5
Integrate

<!--Optional:-->
<typ:name>SYS_className</typ:name>
<!--Optional:-->
<typ:scope/>
<!--Optional:-->
<typ:value>oracle.esshost.impl.CloudAdaptorJobImpl</typ:value>
</typ:parameter>
<typ:parameter>
<!--Optional:-->
<typ:dataType>STRING</typ:dataType>
<!--Optional:-->
<typ:name>SYS_application</typ:name>
<!--Optional:-->
<typ:scope/>
<!--Optional:-->
<typ:value>BI Cloud Adaptor</typ:value>
</typ:parameter>
<typ:parameter>
<!--Optional:-->
<typ:dataType>STRING</typ:dataType>
<!--Optional:-->
<typ:name>EXTRACT_JOB_TYPE</typ:name>
<!--Optional:-->
<typ:scope/>
<!--Optional:-->
<typ:value>VO_EXTRACT</typ:value>
</typ:parameter>
<typ:parameter>
<!--Optional:-->
<typ:dataType>STRING</typ:dataType>
<!--Optional:-->
<typ:name>DATA_STORE_LIST</typ:name>
<!--Optional:-->
<typ:scope/>
<!--Optional:-->
<typ:value>CrmAnalyticsAM.PartiesAnalyticsAM.Location,CrmAnalyticsAM.PartiesAnalyticsAM.Organization,CrmAnalyticsAM.
</typ:value>
</typ:parameter>
<typ:parameter>
<!--Optional:-->
<typ:dataType>STRING</typ:dataType>
<!--Optional:-->
<typ:name>EXTERNAL_STORAGE_LIST</typ:name>
<!--Optional:-->
<typ:scope/>
<!--Optional:-->
<typ:value>storage1</typ:value>
</typ:parameter>
</sch:requestParameters>
</sch:submitRequest>
</soapenv:Body>
</soapenv:Envelope>

Sample Response (submitRequest) - Returns an ESS Job Id

<env:Envelope
xmlns:env="http://schemas.xmlsoap.org/soap/envelope/"
xmlns:wsa="http://www.w3.org/2005/08/addressing">
<env:Header>
<wsa:Action>submitRequest</wsa:Action>
<wsa:MessageID>urn:uuid:b612af67-4769-4eac-9abc-5f2bd8b0ed1bf</wsa:MessageID>
<wsa:RelatesTo>uuid:073d2715-5e6c-4966-4a1f-e1d88da1897b</wsa:RelatesTo>
</env:Header>
<env:Body>
<ns0:submitRequestResponse

35
SOAP Request to Get the Job State (getRequestState)
Pass the Request ID from the submitted job.

Sample Request

```xml
<soapenv:Envelope
  xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/"
  xmlns:ns0="http://xmlns.oracle.com/scheduler">
  <soapenv:Header>
    <wsse:Security
      xmlns:wsse="http://docs.oasis-open.org/wss/2004/01/oasis-200401-wss-wssecurity-secext-1.0.xsd"
      xmlns:wsu="http://docs.oasis-open.org/wss/2004/01/oasis-200401-wss-wssecurity-utility-1.0.xsd">
      <wsse:UsernameToken wsu:Id="UsernameToken-096D9A2FA5EE63DC514744911304045">
        <wsse:Username>faadmin</wsse:Username>
        <wsse:Password Type="http://docs.oasis-open.org/wss/2004/01/oasis-200401-wss-url-token-profile-1.0#PasswordText">xxxxx</wsse:Password>
        <wsse:Nonce EncodingType="http://docs.oasis-open.org/wss/2004/01/oasis-200401-wss-soap-message-security-1.0#Base64Binary">96M4RBdl+afFA6MUufbbAQ==</wsse:Nonce>
        <wsu:Created>2016-09-21T20:52:10.404Z</wsu:Created>
      </wsse:UsernameToken>
    </wsse:Security>
  </soapenv:Header>
  <soapenv:Body>
    <ns0:getRequestState>
      <ns0:requestId>49318</ns0:requestId>
    </ns0:getRequestState>
  </soapenv:Body>
</soapenv:Envelope>
```

Sample Response - Returns the Job State

```xml
<env:Envelope
  xmlns:env="http://schemas.xmlsoap.org/soap/envelope/"
  xmlns:wsa="http://www.w3.org/2005/08/addressing">
  <env:Header>
    <wsa:Action>gs getNodeState</wsa:Action>
    <wsa:MessageID>urn:uuid:b44f932b-2b21-41c0-b748-1ec5007fe05f</wsa:MessageID>
    <wsa:RelatesTo>uuid:374006ab-6fc5-4073-950a-6d6018d1308c</wsa:RelatesTo>
  </env:Header>
  <env:Body>
    <ns0:getRequestStateResponse
      xmlns:ns0="http://xmlns.oracle.com/scheduler">
      <state
        xmlns:ns2="http://xmlns.oracle.com/scheduler/types">RUNNING
      </state>
    </ns0:getRequestStateResponse>
  </env:Body>
</env:Envelope>
```

SOAP Request to Get the Request Detail (getRequestDetail)
Pass the Request ID from the submitted job.
Sample Request

```xml
<soapenv:Envelope
  xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/"
  xmlns:wsse="http://docs.oasis-open.org/wss/2004/01/oasis-200401-wss-wssecurity-secext-1.0.xsd"
  xmlns:wsu="http://docs.oasis-open.org/wss/2004/01/oasis-200401-wss-wssecurity-utility-1.0.xsd">
  <soapenv:Header>
    <wsse:Security
      soapenv:mustUnderstand="1"
      xmlns:wsse="http://docs.oasis-open.org/wss/2004/01/oasis-200401-wss-wssecurity-secext-1.0.xsd"
      xmlns:wsu="http://docs.oasis-open.org/wss/2004/01/oasis-200401-wss-wssecurity-utility-1.0.xsd">
      <wsse:UsernameToken
        wsu:Id="UsernameToken-096D9A2FA5EEE63DC51474918990386">
        <wsse:Username>faadmin</wsse:Username>
        <wsse:Password
          Type="http://docs.oasis-open.org/wss/2004/01/oasis-200401-wss-username-token-profile-1.0#PasswordText">xxxxxx</wsse:Password>
        <wsse:Nonce
          EncodingType="http://docs.oasis-open.org/wss/2004/01/oasis-200401-wss-soap-message-security-1.0#Base64Binary">5WwwW1fii5/6DKpgBafreQ==</wsse:Nonce>
        <wsu:Created>2016-09-21T21:04:59.038Z</wsu:Created>
      </wsse:UsernameToken>
    </wsse:Security>
  </soapenv:Header>
  <soapenv:Body>
    <sch:getRequestDetail>
      <sch:requestId>49318</sch:requestId>
    </sch:getRequestDetail>
  </soapenv:Body>
</soapenv:Envelope>
```

Sample Response - Returns the Job Definition and Status

```xml
<env:Envelope
  xmlns:env="http://schemas.xmlsoap.org/soap/envelope/"
  xmlns:wsa="http://www.w3.org/2005/08/addressing">
  <env:Header>
    <wsa:Action>getRequestDetail</wsa:Action>
    <wsa:MessageID>urn:uuid:bc799307-1819-4667-8ce5-b246405011a1</wsa:MessageID>
    <wsa:RelatesTo>uuid:055a802b-ab9e-46f5-9a87-b54b0e19a4a</wsa:RelatesTo>
  </env:Header>
  <env:Body>
    <ns0:getRequestDetailResponse
      xmlns:ns0="http://xmlns.oracle.com/scheduler">
      <requestDetail
        xmlns:ns2="http://xmlns.oracle.com/scheduler/types">
        <ns2:requestId>49318</ns2:requestId>
        <ns2:description>Test_ESS</ns2:description>
        <ns2:jobDefinitionId
          xmlns:ns2="http://xmlns.oracle.com/scheduler/types">
          <ns2:type>JOB_DEFINITION</ns2:type>
          <ns2:packageName>/oracle.apps.ess.biccc</ns2:packageName>
          <ns2:name>BICloudConnectorJobDefinition</ns2:name>
        </ns2:jobDefinitionId>
        <ns2:dispatcherNode>bi_server1</ns2:dispatcherNode>
        <ns2:processorNode>bi_server1</ns2:processorNode>
        <ns2:workAssignmentId
          xmlns:ns2="http://xmlns.oracle.com/scheduler/types">
          <ns2:type>WORK_ASSIGNMENT</ns2:type>
          <ns2:packageName>/oracle/as/essapp/internal</ns2:packageName>
          <ns2:name>defaultWA</ns2:name>
        </ns2:workAssignmentId>
        <ns2:workshiftId
          xmlns:ns2="http://xmlns.oracle.com/scheduler/types">
          <ns2:type>WORKSHIFT</ns2:type>
          <ns2:packageName>/oracle/as/essapp/internal</ns2:packageName>
          <ns2:name>defaultWS</ns2:name>
        </ns2:workshiftId>
        <ns2:isCancellable>true</ns2:isCancellable>
        <ns2:isHoldable>false</ns2:isHoldable>
        <ns2:retried>0</ns2:retried>
        <ns2:executionAttempt>1</ns2:executionAttempt>
      </requestDetail>
    </ns0:getRequestDetailResponse>
  </env:Body>
</env:Envelope>
```
<ns2:submitter>FAAdmin</ns2:submitter>
<ns2:runAsUser>FAAdmin</ns2:runAsUser>
<ns2:submissionTime>2016-09-21T21:00:38.563Z</ns2:submissionTime>
<ns2:requestTime>2016-09-21T21:00:38.563Z</ns2:requestTime>
<ns2:requestedStartTime>2016-09-21T21:00:38.563Z</ns2:requestedStartTime>
<ns2:scheduledTime>2016-09-21T21:00:38.563Z</ns2:scheduledTime>
<ns2:actualStartTime>2016-09-21T21:00:53.362Z</ns2:actualStartTime>
<ns2:state>RUNNING</ns2:state>
<ns2:priority>4</ns2:priority>
<ns2:cause>Request in non-terminal state</ns2:cause>
<ns2:parentRequestId>0</ns2:parentRequestId>
<ns2:stepId>0</ns2:stepId>
<ns2:requestType>SINGLETON</ns2:requestType>
<ns2:requestParameters>
<ns2:parameter>
<ns2:dataType>INTEGER</ns2:dataType>
<ns2:name>SYS_priority</ns2:name>
<ns2:schedule/>
<ns2:value>4</ns2:value>
</ns2:parameter>
<ns2:parameter>
<ns2:dataType>STRING</ns2:dataType>
<ns2:name>EXTRACT_JOB_TYPE</ns2:name>
<ns2:schedule/>
<ns2:value>VO_EXTRACT</ns2:value>
</ns2:parameter>
<ns2:parameter>
<ns2:dataType>STRING</ns2:dataType>
<ns2:name>SYS_userName</ns2:name>
<ns2:schedule/>
<ns2:value>FAAdmin</ns2:value>
</ns2:parameter>
<ns2:parameter>
<ns2:dataType>INTEGER</ns2:dataType>
<ns2:name>SYS_retries</ns2:name>
<ns2:schedule/>
<ns2:value>0</ns2:value>
</ns2:parameter>
<ns2:parameter>
<ns2:dataType>STRING</ns2:dataType>
<ns2:name>SYS_className</ns2:name>
<ns2:schedule/>
<ns2:value>oracle.esshost.impl.CloudAdaptorJobImpl</ns2:value>
</ns2:parameter>
<ns2:parameter>
<ns2:dataType>LONG</ns2:dataType>
<ns2:name>SYS_request_timeout</ns2:name>
<ns2:schedule/>
<ns2:value>0</ns2:value>
</ns2:parameter>
<ns2:parameter>
<ns2:dataType>STRING</ns2:dataType>
<ns2:name>SYS_groupName</ns2:name>
<ns2:schedule/>
<ns2:value>ESS_DefaultIsolationGroup</ns2:value>
</ns2:parameter>
<ns2:parameter>
<ns2:dataType>STRING</ns2:dataType>
<ns2:name>SYS_submittingApplication</ns2:name>
<ns2:schedule/>
<ns2:value>oracle.biacm</ns2:value>
</ns2:parameter>
<ns2:parameter>
<ns2:dataType>BOOLEAN</ns2:dataType>
<ns2:name>SYS_EXT_userFileDirShared</ns2:name>
<ns2:schedule/>
<ns2:value>false</ns2:value>

Schedule a Job

Let's look at how to submit schedules for existing jobs using ESS request. You can get the job Id from the Manage Jobs page.

<table>
<thead>
<tr>
<th>SOAP Headers</th>
<th>Procedure</th>
</tr>
</thead>
</table>
| Security     | - Click the **Auth** tab to provide authentication information for accessing the web service.  
               - Enter the username and password. |

<table>
<thead>
<tr>
<th>SOAP Body</th>
<th>Provide details for the following attributes in the SOAP Body.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- Job Name: BICloudConnectorJobDefinition</td>
</tr>
<tr>
<td></td>
<td>- Package: oracle.apps.ess.biccc</td>
</tr>
<tr>
<td></td>
<td>- Type: JOB_DEFINITION</td>
</tr>
<tr>
<td></td>
<td>- Start Time: Provide start time under sch:requestedStartTime. If left null, the extract process will start immediately.</td>
</tr>
<tr>
<td></td>
<td>- sch:application: oracle.biacm (hosting application)</td>
</tr>
<tr>
<td></td>
<td>- Request Parameters.</td>
</tr>
</tbody>
</table>

```xml
<nss2:parameter>
  <nss2:parameter>
    <nss2:dataType>INTEGER</nss2:dataType>
    <nss2:name>SYS_requestExpiration</nss2:name>
    <nss2:scope/>
    <nss2:value>0</nss2:value>
  </nss2:parameter>
  <nss2:parameter>
    <nss2:dataType>STRING</nss2:dataType>
    <nss2:name>SYS_application</nss2:name>
    <nss2:scope/>
    <nss2:value>oracle.biacm</nss2:value>
  </nss2:parameter>
  <nss2:parameter>
    <nss2:dataType>STRING</nss2:dataType>
    <nss2:name>SYS_userFileDir</nss2:name>
    <nss2:scope/>
    <nss2:value>${ESS_ENV:jrfServerLogPath}/ess_request</nss2:value>
  </nss2:parameter>
  <nss2:parameter>
    <nss2:dataType>INTEGER</nss2:dataType>
    <nss2:name>SYS_reprocessDelay</nss2:name>
    <nss2:scope/>
    <nss2:value>5</nss2:value>
  </nss2:parameter>
  <nss2:parameter>
    <nss2:dataType>BOOLEAN</nss2:dataType>
    <nss2:name>SYS_executePast</nss2:name>
    <nss2:scope/>
    <nss2:value>true</nss2:value>
  </nss2:parameter>
</nss2:requestParameters>
<nss2:ecid>5aa4a1152ec38837:-422f90c2:157393de3be:-8000-00000000006e4bc</nss2:ecid>
<nss2:processPhase>ExecuteFinalize</nss2:processPhase>
</nss2:requestDetail>
</nss0:getRequestDetailResponse>
</nss:Body>
</nss:Envelope>
## SOAP Headers

<table>
<thead>
<tr>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>a. SYS_className:oracle.esshost.impl.CloudAdaptorJobImpl (ClassName in the hosting app running the job)</td>
</tr>
<tr>
<td>b. SYS_requestCategory: JobSchedule (Identifies as a schedule for a Job definition)</td>
</tr>
<tr>
<td>c. EXTRACT_JOB_TYPE: Job Type of the extract. Valid values are VO_EXTRACT (Application Data Extract)/PRIMARY_KEY_EXTRACT Active Primary Key Extract)/VO_AND_PK_EXTRACT (Application Data and Active Primary Key extract)</td>
</tr>
<tr>
<td>d. EXTERNAL_STORAGE_LIST: External Storages to upload the files to. You can obtain the external storage names from the BICCC UI -&gt;Configure External Storage. You can upload files to a maximum of two external storages.</td>
</tr>
<tr>
<td>e. JOB_ID: Job Id for which the schedule is being created.</td>
</tr>
<tr>
<td>f. Optional Preferences: You can specify the following optional preferences. You can specify data type as STRING for all the parameters.</td>
</tr>
<tr>
<td>g. STARTED_NOTIFICATION - Send notification email when the extract begins? (true/false).</td>
</tr>
<tr>
<td>h. SUCCESS_NOTIFICATION – Send notification email when the extract succeeds? (true/false).</td>
</tr>
<tr>
<td>i. FAILURE_NOTIFICATION - Should notification email be sent when the extract failed? (true/false).</td>
</tr>
<tr>
<td>j. MAIL_TO_ADDRESSES - Comma separated list of email addresses to whom the notification should be sent.</td>
</tr>
<tr>
<td>k. FILE_EXPIRY_DAYS - Number of days after which the uploaded files will be expired.</td>
</tr>
<tr>
<td>l. FILE_SPLIT_SIZE - Split size (MB) for the extract files.</td>
</tr>
<tr>
<td>m. EXTRACT_COMPRESS_TYPE - Compression type for the files (zip/gzip).</td>
</tr>
<tr>
<td>n. EXTERNAL_STORAGE_FILE_NAME_PREFIX - Uploaded file name prefix support for OCI Object Storage.</td>
</tr>
<tr>
<td>o. sys_application:BI Cloud Adaptor.</td>
</tr>
</tbody>
</table>

### Sample Request

```
<sch:submitRequest>
  <sch:description>job schedule test 1</sch:description>
  <sch:jobDefinitionId/>
  <sch:jobDefinitionId/>
    <typ:name>BICloudConnectorJobDefinition</typ:name>
    <typ:packageName>oracle.apps.ess.biccc</typ:packageName>
    <typ:type>JOB_DEFINITION</typ:type>
  </sch:jobDefinitionId>
  <sch:application>oracle.bi.acm</sch:application>
  <sch:requestParameters>
    <typ:parameter>
      <typ:dataType>STRING</typ:dataType>
      <typ:name>SYS_className</typ:name>
      <typ:value>oracle.esshost.impl.CloudAdaptorJobImpl</typ:value>
    </typ:parameter>
    <typ:parameter>
      <typ:dataType>STRING</typ:dataType>
      <typ:name>SYS_requestCategory</typ:name>
    </typ:parameter>
  </sch:requestParameters>
</sch:submitRequest>
```
Oracle BI Cloud Connector Console
Creating a Business Intelligence Cloud Extract

Chapter 5
Integrate

<html>
<head></head>
<body>

<!--Optional:-->
</typ:value>JobSchedule</typ:value>
</typ:parameter>
<!--Optional:-->
</typ:parameter>
<!--Optional:-->
</typ:parameter>
<!--Optional:-->
</typ:parameter>
<!--Optional:-->
</typ:parameter>
<!--Optional:-->
</typ:parameter>
<!--Optional:-->
</typ:parameter>
<!--Optional:-->
</typ:parameter>
<!--Optional:-->
</typ:parameter>
<!--Optional:-->
</typ:parameter>
<!--Optional:-->
</typ:parameter>
</sch:requestParameters>
</sch:submitRequest>

Troubleshooting

If the ESS web service fails and displays the error message "Security Token Is Not Valid", verify that the timestamp in the SOAP header is valid and hasn't expired. If expired, generate a new timestamp and resubmit the request.

<wsu:Timestamp wsu:Id="TS-A2DF758C7B92C0123015204688873404">  
<wsu:Created>2018-03-08T00:28:07.339Z</wsu:Created>
<wsu:Expires>2018-03-08T00:30:07.339Z</wsu:Expires>
</wsu:Timestamp>

REST API

You can use Oracle REST APIs to view data store extract metadata.

</body>
</html>
Access REST API
To make a REST HTTP request, you need to gather a few bits of information:

- **REST Server URL**: Typically, the URL of your Oracle Cloud service. For example, https://servername.fa.us2.oraclecloud.com:<host:port>/biacm/rest
- **User name and password**: An Oracle Cloud service user with permissions to access the resources you’re using.

You can find the REST Server URL, user name, and password in the welcome email sent to your Oracle Cloud service administrator.

Get DataStoreMeta
Get a DataStore metadata by passing "dataStoreId" as PathParam. QueryParam "locale" is optional.

Example URL
Here’s an example of the resource URL:

GET
/meta/datastores/CrmAnalyticsAM.PartiesAnalyticsAM.Person
/meta/datastores/CrmAnalyticsAM.PartiesAnalyticsAM.Person?locale=ko

Example Response
Here’s an example of the response body in JSON format:

```
{
  "dataStoreId": "CrmAnalyticsAM.PartiesAnalyticsAM.Person",
  "dataStoreName": "CrmAnalyticsAM.PartiesAnalyticsAM.Person",
  "filters": null,
  "isEffectiveDateDisabled": false,
  "isFlexDataStore": false,
  "isSilentError": false,
  "columns": [{
    "name": "CreatedBy",
    "label": "Created By",
    "dataType": "VARCHAR",
    "size": "64",
    "precision": "64",
    "scale": "-127",
    "isPrimaryKey": false,
    "isPopulate": true,
    "isLastUpdateDate": false,
    "isNaturalKey": false
  }, {
    "name": "CreationDate",
    "label": "Creation Date",
    "dataType": "TIMESTAMP",
    "size": "0",
    "precision": "0",
    "scale": "-127",
    "isPrimaryKey": false,
    "isPopulate": true,
    "isLastUpdateDate": false,
    "isNaturalKey": false
  }, {
    "name": "LastUpdateDate",
    "label": "Last Updated Date",
    "dataType": "TIMESTAMP",
    "size": "0",
    "precision": "0",
```
VO Metadata Expected Behavior

This section provides additional details about Metadata API attributes for SDM VO and Non SDM VOs.

The following table lists the difference in the VO attributes for SDM VO and Non SDM VOs.

<table>
<thead>
<tr>
<th>VO Attribute</th>
<th>SDM VO (Attribute Fetched)</th>
<th>Non SDM VO (Attribute Fetched)</th>
</tr>
</thead>
<tbody>
<tr>
<td>dataStoreId</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>dataStoreName</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>filters</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>isEffectiveDateDisabled</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>isFlexDataStore</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>isSilentError</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>
The following table lists the difference in the Column attributes for SDM VO and Non SDM VOs.

<table>
<thead>
<tr>
<th>VO Attribute</th>
<th>SDM VO (Attribute Fetched)</th>
<th>Non SDM VO (Attribute Fetched)</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>label</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>dataType</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>size</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>precision</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>scale</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>isPrimaryKey</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>isPopulate</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>isLastUpdateDate</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>isNaturalKey</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>isEffectiveStartDate</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>isCreationDate</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>colConversion</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

Get DataStoreMeta with User Customization

Get a DataStore metadata by passing "dataStoreId" as PathParam. QueryParam "locale" is optional.

Example URL

Here's an example of the resource URL:

GET
/meta/datastores/CrmAnalyticsAM.PartiesAnalyticsAM.Person?includeCustomization=true
/meta/datastores/CrmAnalyticsAM.PartiesAnalyticsAM.Person?includeCustomization=true&locale=ko

Example Response

Here's an example of the response body in JSON format:

```json
{
    "dataStoreId": "CrmAnalyticsAM.PartiesAnalyticsAM.Person",
    "dataStoreName": "CrmAnalyticsAM.PartiesAnalyticsAM.Person",
    "filters": null,
    "isEffectiveDateDisabled": false,
    "isFlexDataStore": false,
    "isSilentError": false,
    "columns": [{
        "name": "CreatedBy",
```
"label": "Created By",
"dataType": "VARCHAR",
"size": "64",
"precision": "64",
"scale": "-127",
"isPrimaryKey": false,
"isPopulate": true,
"isLastUpdateDate": false,
"isNaturalKey": false
},

{name: "CreationDate",
label: "Creation Date",
dataType: "TIMESTAMP",
size: "0",
precision: "0",
scale: "-127",
isPrimaryKey: false,
isPopulate: true,
isLastUpdateDate: false,
isNaturalKey: false
},

{name: "LastUpdateDate",
label: "Last Updated Date",
dataType: "TIMESTAMP",
size: "0",
precision: "0",
scale: "-127",
isPrimaryKey: false,
isPopulate: true,
isLastUpdateDate: true,
isNaturalKey: false
},

{name: "LastUpdatedBy",
label: "Last Updated By",
dataType: "VARCHAR",
size: "64",
precision: "64",
scale: "-127",
isPrimaryKey: false,
isPopulate: true,
isLastUpdateDate: false,
isNaturalKey: false
},

{name: "PartyId",
label: "PartyId",
dataType: "NUMERIC",
size: "8",
precision: "18",
scale: "0",
isPrimaryKey: false,
isPopulate: true,
isLastUpdateDate: false,
isNaturalKey: false
},

{name: "PersonProfileId",
label: "PersonProfileId",
dataType: "NUMERIC",
size: "8",
precision: "18",
scale: "0",
isPrimaryKey: true,
isPopulate: true,
isLastUpdateDate: false,
isNaturalKey: false
}
Create or Update Data Store

Use this method to create or update a data store. For example, to add filters to a data store. Get a DataStore metadata by passing 'dataStoreId' as PathParam. Add the required filter to the 'filters' attribute and a rootkey `dsmeta` to the JSON file.

Example URL

Here's an example of the resource URL:

PUT

/meta/datastores/

Sample Request

Here's an example of sample request body in JSON format.

```json
{
  "offerings": ["HR_AN_OFRNG"],
  "dsmeta": {
    "dataStoreId": "CrmAnalyticsAM.GeographiesAnalyticsAM.ZoneHelper",
    "dataStoreName": "CrmAnalyticsAM.GeographiesAnalyticsAM.ZoneHelper",
    "filters": null,
    "isEffectiveDateDisabled": false,
    "isFlexDataStore": false,
    "isSilentError": false,
    "columns": [
      {
        "name": "MasChildId",
        "label": "MasChildId",
        "dataType": "NUMERIC",
        "size": "8",
        "precision": "0",
        "scale": "-127",
        "isPrimaryKey": false,
        "isPopulate": true,
        "isLastUpdateDate": false,
        "isNaturalKey": false,
        "isEffectiveStartDate": false,
        "isCreationDate": false,
        "colConversion": null
      },
      {
        "name": "MasHierarchyNodeId",
        "label": "MasHierarchyNodeId",
        "dataType": "NUMERIC",
        "size": "8",
        "precision": "18",
        "scale": "0",
        "isPrimaryKey": true,
        "isPopulate": true,
        "isLastUpdateDate": false,
        "isNaturalKey": false,
        "isEffectiveStartDate": false,
        "isCreationDate": false,
        "colConversion": null
      },
      {
        "name": "MasLastUpdateDate",
        "label": "MasLastUpdateDate",
        "dataType": "TIMESTAMP",
        "size": "0",
```
Get Job Definition

Get a Job definition by passing "jobId" as PathParam. For example - /meta/jobs/1

Example URL

Here's an example of the resource URL:

GET

/meta/jobs/{jobId}

Sample Response

```json
{
    "dataStores": [
        {
            "dataStoreMeta": {
                "columns": [
                    {
                        "name": "CreatedBy",
                        "isPrimaryKey": false,
                        "isPopulate": false,
                        "isLastUpdateDate": false,
                        "isNaturalKey": false,
                        "isEffectiveStartDate": false,
                        "isCreationDate": false,
                        "colConversion": null
                    },
                    {
                        "name": "CreationDate",
                        "isPrimaryKey": false,
                        "isPopulate": false,
                        "isLastUpdateDate": false,
                        "isNaturalKey": false,
                        "isEffectiveStartDate": false,
                        "isCreationDate": false,
                        "colConversion": null
                    }
                ]
            }
        }
    ]
}
```
Create or Update Job

Use this method to create or update a job. For example - /meta/jobs/

Example URL

Here’s an example of the resource URL:

PUT

/meta/jobs/

Sample Request

{  
  "dataStores": [  
    {  
      "dataStoreMeta": {  
        "columns": [  
          {  
            "name": "CreatedBy",  
            "isPrimaryKey": false,  
            "isPopulate": false,  
            "isLastUpdateDate": false,  
            "isNaturalKey": false,  
            "isEffectiveStartDate": false,  
            "isCreationDate": false,  
            "colConversion": null  
          },  
          {  
            "name": "CreationDate",  
            "isPrimaryKey": false,  
            "isPopulate": false,  
            "isLastUpdateDate": false,  
            "isNaturalKey": false,  
            "isEffectiveStartDate": false,  
            "isCreationDate": false,  
            "colConversion": null  
          }  
        ]  
      }  
    }  
  ]
}
"isNaturalKey": false,
"isEffectiveStartDate": false,
"isCreationDate": true,
"colConversion": null
},

{"name": "EnabledFlag",
"isPrimaryKey": false,
"isPopulate": false,
"isLastUpdateDate": false,
"isNaturalKey": false,
"isEffectiveStartDate": false,
"isCreationDate": false,
"colConversion": null
},

{"name": "LastUpdateDate",
"isPrimaryKey": false,
"isPopulate": false,
"isLastUpdateDate": false,
"isNaturalKey": false,
"isEffectiveStartDate": false,
"isCreationDate": false,
"colConversion": null
},

{"name": "LastUpdatedBy",
"isPrimaryKey": false,
"isPopulate": false,
"isLastUpdateDate": false,
"isNaturalKey": false,
"isEffectiveStartDate": false,
"isCreationDate": false,
"colConversion": null
},

Sample Response

{
  "status": "<SUCCESS/SUCCESS_WITH_WARNING>",
  "id": "<JOB_ID>",
  "message": "<Any warning message>
}